EPANET mudeli import (WaterGEMS)

Olles labinud sissejuhatava 6ppematerjali WaterGEMS tarkvarasse, vaatame siinkohal, kuidas EPANET
mudelit importida WaterGEMS tarkvarasse ja mis on need peamised satted, mida tuleks kontrollida
vOi soovi korral muuta.

EPANET *.inp faili loomine

Enamus veevorkude modelleerimispakette (tasuta voi tasulised) toetavad EPANET mudelite importi
[abi *.inp faili (meenutusena, EPANET projekti fail on laiendiga *.net). Seega esmalt tuleb meil EPANET-
ist eksportida *.inp fail.

e Vali meniiist File > Export > Network...

File Edit View Project Report Window Help

New =L M <Ay
Open...

Save

Save As...

Import »
Export » Map...

5 10,
Page Setup... CENArio

Print Preview

Metwork... I}

e Salvesta fail projekti kataloogi sama nimetusega, mis ka projekti fail (nii on neil lihtsam silma
peal hoida, mis versioonist tehtud). Kliki Save.

File name: | PGO0_EPAMET-D110.inp

Save as type:  Input files (*.INP)

e EPANET tarkvara void nild sulgeda.

Markus. Meenutusena, *.inp faili voib avada ka tavalise tekstiredaktoriga. Seda v&ib ka muuta
andmete tdhenduses, kuid tuleb olla ettevaatlik, et sektsioonid jaaksid paika ning ka andmestruktuuri
ei muudaks. Naiteks voib kasutada tabelarvutusprogrammi, *.inp faili sektsioonid kopeerida Excelisse,
teostada muudatusi ja siis tagasi *.inp faili kleepida. Pane tdhele, et EPANET-iga saad avada nii *.net
kui *.inp faile (seega ka muudetud sisuga *.inp faile kui andmestruktuur peab paika).
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EPANET import WaterGEMS projektiks
Kaivita WaterGEMS tarkvara.

1. WaterGEMS kasutajaliideses vali File > Import > EPANET

Import
WaterGEMS/HAMMER
Database
EPANET
Submodels
Results

2. Vali eelnevalt eksporditud *.inp fail, kliki Open

Mame

| | PGOo_EPANET-D110.inp

3. Kuvatakse dialoog, kas import Onnestus voi esines torkeid. Hetkel on k&ik korras! Sulge

punasest ristist antud dialoog.
User Notifications n
lerts and Alamms
b @
[search v|p
Element Type Blement Id  Label Time (hours) Message
(N/A) (N/A) Operation completed successfully in 2 seconds.

Message Id Scenario
(N/AY 0

i B (N/A)
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4. Salvesta WaterGEMS projekt, kliki File > Save

©

Open
Browse

New

Open

Close

Close All

5. Meenutusena, WaterGEMS projekti faili laiend on *.wtg, kuid sellega lihes salvestatakse veel
ks oluline fail, laiendiga *.sqlite (see on andmebaas, mis kannab endas vorgu kohta kdivat
infot, parameetreid jmt). Kliki Save.

File name: | PGO0_WaterGEMS-D110.wig

Save as type:  WaterGEMS Hydraulic Model Files (*owtg)

6. Vaata salvestatud asukohta, ja pane tahele nii *.wtg kui *.sqlite I6puga faili. Pane tahele, et
nende esimene ots peab olema tapselt Ghtmoodi nimetatud, muidu ei ole véimalik projekti
avada. Seega ei ole soovitav File Explorer vahendusel neid faili nimesid muutma.

D PGO0_WaterGEMS-D110.wtg
PGO0_WaterGEMS-D110.wtg.sqlite

7. Sellega oled edukalt importinud EPANET mudeli WaterGEMS projektiks. Sul on soovi korral
vOimalik ka vastupidi teha. Eksportida WaterGEMS projekt EPANET failiks, kuid hetkel meil
seda teha pole vaja, kuna jatkame t66d WaterGEMS tarkvaras.
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WaterGEMS [PGO0_WaterGEMS-D110untg]

PGO0_ Wt erGEMS D110ty

o “w[§

St i semert o Dbyt k-

X074 m W 845555784 | Zoom ek 7% 2

WaterGEMS projekti sdtete kontroll

Siinkohal me ei vaata Uldiseid satteid, mida on kasitletud varasemates WaterGEMS naidetes, kuid
moned olulised asjad kordame (le, mida vdiks peale EPANET importi kontrollida.

1. Soovides mudeli s6lmi paremini kuvada, mitte neid naha alles mudeli sisse suurendades, vali
Element Symbology paletilt GIS Style.
| Hement Symbology . x
<default > w
=l % - %-E- 0
CAD Style
78 Fioe GIS Style
@ o Lateral
2.

Projekti arvutusseadeid saad kontrollida Home > Options vahendusel (Calculation Options
dialoog)

Home Layout

E'Alternatives
= Options

Scenarios
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3. Valiseejarel Base Calculation Options

Calculation Options

X W=l

Search

B Steady State/EPS Solver

R B} Base Calculation Options
- Transient Solver

----- [#] Base Calculation Options

4. Vaata Properties paletti ning veendu, et pdhiseaded oleksid need, mis ka EPANET-is paika
seatud. Vajadusel muuda. Naiteks survekao meetod (Friction Method).

Properties - Calculation Options -Base C... 1 X

[ Jee

<Show All>
|PI'D|:IBI‘[}' Search v P2~
v  «<General>
O 45
Label Base Caleulation Options
Mates
Friction Method Darcy-Weisbach

Output Selection Set «All>
Calculation Type Hydraulics Cnly
~  Adjusimenis
Demand Adjustments  Active
Active Demand Adjust <Collection: 1 tem:
Unit Demand Adjustme Mone
Reoughness Adjustmen Mone
* Calculabon Flags
Display Status Messag True
Display Calculation FI. True
Display Time Step Cor True
v Calculation Times
Simulation Start Date  01.01.2000
Time Anzlysis Type  Steady State
Use simple controls di True
|z EPS Snapshot? False
Start Time D0:00:00
+ Hydraulics
Engine Compatibility EPAMET 2.00.12
Convergence Check F 2
Convergence Check C 10

Damping Limit 0.000

Trials 40

Accuracy 0.001

Continue If Unbalance: True

Extra Iterations 10

Emitter Exponent 0.500

Liguid Label Water at 20C(68F)

Liguid Kinematic Viscc 1.022e-006
Liguid Specific Gravity 1.000
Minimum Possible Pre -37

Use Pressure Depend: False
Calculate Customer Ry False

5. WaterGEMS véimaldab muuta projekti tGhikuid viisil, kus andmed ka konverteeritakse. Siiski on
soovitus, et EPANET mudelis oleksid andmed tehtud digetes thikutes ja pole kogemata tehtud
sisestusvigasid (nt sisestatud s6lme kdrgusena 10 m, aga kogemata jadnud Ghikusilisteem jalad,
sellist viga on hiljem juba palju keerulisem parandada, sest see ei ole konverteerimisega
taastatav, vaid tuleb kasutada ka juba lisakordajaid). Vali Tools > Options .
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View Tools Report Bentley Cloud Services

Home Layout Analysis Components Review
io! om0 F\;\ ¥ LoadBuilder Pj }\‘} iifo Skelebrator Skeletonizer

10:
ey =i
Q f z\!.;‘ e Thiessen Polygon 4+ User Data Extensions
Active MadelBuilder TRex GIS-ID  External .
Topology * Center~ Tools* = More
Model Creation Tools N
: Hement Symbology 1 x "~ PG00 Options
<default> v Base Specify application and project L@ 0 O
y o~ P options, - T
O X = &%- B-E- 0

6. Paanil Units veendu, et oleks kasutusel Sl (hikusisteem. WaterGEMS vdimaldab iga
omaduse/parameetri juures muuta thikuid ka eraldiseisvalt. Sulge seejarel dialoog.

Options X
Global Hydraulic Model Drawing Units | abeling ProjectWise Engine

H Save As.. | ¥ Load... 5 Reset Defaults -

Diefault Umit System for New Hydraulic Model 5l e

7. Konkreetse omaduse (ihikut saab muuta mistahes hetkel ka tabelvaadetest, nt Properties

paletil olles ja paremat klikki tehes:

Is Constituent Source? False
Trace (Initial) (%) 0.0
v Resulis

Grade (m)  (NAA)
(N/A)

Units and Fermatting...
pi (N78)

(N/A)

(N/A)

lezsi <Mone>

8. Avanevas dialoogis saame Umber valida ihiku ning ka komakohtade arvu.

it ‘ Se" T'2E2EJ,S_23

—~
e e D5 If qa_ﬂ?—as ?ﬁgg S-80

~ Set Field Options - Pressure

Preview
’7Value: 010 m H20
Cancel
Unit: m H20 ~
Help
Display Precision: 2
Format: Number ~

Markus. Pane tdhele, et Gihiku Gmber valimisega tehakse ka vaartuse konverteerimine.

9. Konkreetse parameetri vaartuseid on kdige lihntsam muuta labi tabeliliidese (FlexTables). Vali
naiteks torude tabel: Home > FlexTables > Pipe
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Home | layout  Analysis  Components  Review  View  Tools  Report  Bentley Cloud Services
E[l: [E# Alternatives @ Validate [8] Notifications E]}-S o0—o b %, ByPolygon | W Lz:; [ Patterns m i)} Selection Sets
a
B = options £ Times Alerts e o By Element ™ | #f % 5 bump Definitions [ properties
Scenarios Compute Layout Measure = Select Demand Graphs FlexTables
- - B Summary - ~ By ByAttribute ™ | %2 | Conter~ 58 Controls ~ & Refresh ~
Calculation Drawing Comme¢ [F] FlexTables Cirl+7 on Views
HE= =S, o * X | PGO0_WaterGEMS-D110.wtg | & Pipe N
— e Base v|2a S0l - @ Q Ot Bl Gt - [{ £ Laten

10. Soovide naiteks muuta koikide torude labimd06tu, tee parem klikk Diameter péisel ning vali
Global Edit... (FlexTable vahendusel saad muuta neid omadusi, mis on valge taustaga)

[7] FlexTable: Pipe Table (PGO0_WaterGEMS-D110.wtg)
=R RN =R TR N
Length )
o) Label (Scaled) Start Node Stop Node D‘z:';;ﬁr Material Hazen Wilkiams
(m) Units and Formatting...
161: T-83 161|783 87/s-39 541 I
162: T-82 162 |T-82 84(5-37 5-39 . SHstes..
163: T-73 163 |T-73 100 |5-36 5-37 | Global Edit... |\ |
164: T-72 164|172 8 |5-34 536 =] Edit Column Label...
165: T71 165 |T-71 8 |5-32 5-34 |
2] Sort 3
166: T-66 166 |T-66 %6 |s-30 5-32
167: T-65 167 T-65 100 [5-29 5-30 Filter 4

11.

Diameter Material Hazen-Wiliams Has Chedk
{mim) b=tz C Valve?
40,0 Ductile Iron 1.0 r
40,0 | Ductile Iron 1.0 r
40.0 | Ductile Iron 1.0 I
a0.0 DI._I_'I_ —— PR |
50.0 | O Global Edit
50,0 | D
50.0 (D  Operation: Set w
S0.0 18 Walue: 96.8
40.0 |DO
40.0|p WHERE: <no fiter active=
40.0 | D

Kuvatavas dialoogis veendu, et operaatoriks oleks Set (soovid asendada) ning lisa vaartuseks
nditeks uus torude siseldbimd6t, mida rakendatakse koikidele torudele

Markus. Moistagi void vaartuseid muuta ka Ghe kaupa, nt Properties paleti vahendusel. Oletame, et
peatoru on suurema labimddduga. Lisaks sellele on véimalik teha ka omaduste gruppe ja teostada
muudatusi Ghe konkreetse grupi piires (nt peatorud, lisatorud jne). Ja see kehtib ka mistahes teistele

omadustele samamoodi.

Markus. Juhul kui soovid teatud vaartustega katsetada, nt tiks mudel, milles torud Ghe labimddduga ja
teine mudel, milles torud teise labim66duga, siis selleks on mdistlik juba kasutada stsenaariume

(Scenarios).
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WaterGEMS elementide esitusviis

Uldjuhul loome mudeleid 1:1-le, ehk siis naiteks meetersiisteemis, kus toru pikkus arvutatakse
koordinaatides. Kuna EPANETi mudelis me skaleerisime enda mudeli, ja lisasime ka tegeliku
koordinaadi, siis tuleb see info ka WaterGEMSi (le.

1. Vali moni s6lm ja pane tdhele, et Properties paletil on X (m), Y (m) — need vastavad Eesti
koordinaatsiisteemile ja seega saame oma mudelit koordineerida muu GIS/BIM infoga.

4 p x| : Properties - Junction - 5-21 (142) 1 X
B e
—H «<Show All» v .
5-29 |P|tu|:uE|t',- Search w p -
v <General>
C 142
Label S5-21
Motes
GI=-1Ds <Collection: 0 tems:
Hyperlinks <Collection: 0 tems:
v  <Geomelry>
Hm) 405 546.10
Y (m) E 455 380.79
v  Active Topology
Is Active? True
+ Demand
Demand Callection <Collection: 1item:
Unit Demand Cellectio <Collection: 0 tems:
Associated Customer | <Collection:
Associated Customer | «<Collection:

Markus. Kui need X, Y ei vasta ndutud/eeldatud vaartustele, peaks EPANET mudeli uuesti
koordineerima (skaleerima) ja teostama uue impordi.

2. Seega, meetersistemis tehtud mudelis ndeme toru tegelikku pikkust ja kui me peaksime sélme
asukohta muutma, siis arvutatakse ka toru pikkus Gmber (sarnaselt EPANET tarkvarale). Samas
on oluline tahele panna, et WaterGEMS hoiab ja kuvab kahte erinevat pikkust, Ghte, mis on
tegelik ja teist, mis on kasutaja poolt Ule kirjutatud. Alloleval pildil on need vaartused Length
(User Defined) (m) ning Length (m).

E-21 w  Physical
Zone <Mone:
Diameter (mm) 50.0
Material Ductile Iron

Darcy-\Weisbach & (mm) 1.0000
Has User Defined Length? True

o Length (User Defined) (m) 58

P ha
Has Check Valve? False

5.02 Specify Local Minor Loss? True

Minor Loss Coefficient (Local) 0.000
DMA Status Boundary Candidate
Year Installed 1]
Year Retired 1]

Markus. Pane tahele, et tegelik pikkus, Length (m), on hetkel halltoonis ja kasutatakse vaartust Length
(User Defined) (m), sest omadus Has User Defined Length? = True.
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Mirkus. Uldine soovitus, et kui tegemist on toruga, millega soovitakse esitada tegelikku pikkust, siis
oleks ka Has User Defined Length (m) = False. TGsi, hetkel vahet pole, kuna mdélemad vaartused
kattuvad, samas kui me niitid nihutame (hte s6lme, siis paneme tahele, mis muutub!

=-2

Fafigl ¥

S-22

* [Dperational

Controls

Physical

Zone

Diameter (mm)

Material

Darcy-\Weisbach & (mm)
Has User Defined Length?
Length (User Defined) (m)

Has Check Valve?
Specify Local Minor Loss?

Minor Loss Coefficient (Local)

DMA Status

Year Installed
Year Betired

<Collection

<Mones
50.0
Ductile Iron
1.0000
True

53

53

False

True

0.000
Boundany Candidate

0
1]

Vaartus jaab endiselt kui 58 meetrit. Ehkki me venitasime toru pikemaks. Kui niiiid aga muuta Has User
Defined Length? = False peale, ndeme ka tegeliku pikkuse muutust. Vaartus on tegelikult 69 meetrit.
Nudd kuvatakse molemat vaartust halltoonis, mis tdhendab, et neid kasitsi muuta ei saa.

5-21

e

S5-22

+ Dperatonal

Controls
Physical
Zone
Diameter (mm)
Materizl
Darcy-Wweisbach & (mm)

<Collection=

<Mone:
0.0
Ductile Iron
1.0000

Has User Defined Length? RS |

Has Check Valve?
Specify Local Minor Loss?

&5
65
Falze
True

Minor Loss Coefficient (Local) 0.000

[ ¥, I Y

Dlms vemid =i e (7 Aid =4

Hetkel taastan endise olukorra (Undo).

3. Me saame kiirelt kehtestada kéikide torude tegelikud pikkused |abi FlexTable liidese. Sarnaselt
eelnevale Pipe tabelis, veeru Has User Defined Length? parem klikk ning valik Global Edit...
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Headloss Has User Length (User Darcy-Weisbach e

Gradient Defined Defined) oo
({m,fm} Length? -

[T STt
N/AY ] =] Edit Column Label... 1.0000
/A A 1,0000

2] Sort »
(n/a) v . 1.0000

Filter 3
(fa) v _ 1.0000
(/2 v Reapply Sort/Filter 1.0000

4. Avanevas dialoogis, kuna soovime linnukest dra votta, siis jdab kast tiihjaks ja klikime OK.

Global Edit X

Operation: Set ~
Value: O
WHERE: <no fiter active>

5. Niid on kdik meie torud tegeliku pikkust kaasavad. Maistagi, kui ménes kohas olime soovinud
kasutada kasitsi sisestatud vaartust, siis peame selles osas vastava toru juures muudatused
uuesti tegema. Antud vdimalust saabki dra kasutada naiteks pumplate viljajoonestamiseks,
kus pumpla asub kilomeetrite kaugusel vdi siis soovime pumpla torusid tapsete pikkusetega
joonistada ja kuna need on lldjuhul lihikesed torud, siis on tegeliku pikkusega seda joonist
vaga raske lugeda. Panemegi linnukese, et kasutaja enda toru pikkus ning triikime vastavasse
kasti soovitud vaartuse. Vaga oluline, et me siinkohal kogemata viga ei tee. Sest sellisel juhul
mojutame olulisel maaral survekadusid!
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